
Chapter 15: Using Dynamic Meshes

This tutorial is divided into the following sections:

15.1. Introduction

15.2. Prerequisites

15.3. Problem Description

15.4. Setup and Solution

15.5. Summary

15.6. Further Improvements

15.1. Introduction

In ANSYS Fluent the dynamic mesh capability is used to simulate problems with boundary motion, such

as check valves and store separations. The building blocks for dynamic mesh capabilities within ANSYS

Fluent are three dynamic mesh schemes, namely, smoothing, layering, and remeshing. A combination

of these three schemes is used to tackle the most challenging dynamic mesh problems. However, for

simple dynamic mesh problems involving linear boundary motion, the layering scheme is often sufficient.

For example, flow around a check valve can be simulated using only the layering scheme. In this tutorial,

such a case will be used to demonstrate the layering feature of the dynamic mesh capability in ANSYS

Fluent.

Check valves are commonly used to allow unidirectional flow. For instance, they are often used to act

as a pressure-relieving device by only allowing fluid to leave the domain when the pressure is higher

than a certain level. In such a case, the check valve is connected to a spring that acts to push the valve

to the valve seat and to shut the flow. But when the pressure force on the valve is greater than the

spring force, the valve will move away from the valve seat and allow fluid to leave, thus reducing the

pressure upstream. Gravity could be another factor in the force balance, and can be considered in ANSYS

Fluent. The deformation of the valve is typically neglected, thus allowing for a rigid body Fluid Structure

Interaction (FSI) calculation, for which a user-defined function (UDF) is provided.

This tutorial provides information for performing basic dynamic mesh calculations by demonstrating

how to do the following:

• Use the dynamic mesh capability of ANSYS Fluent to solve a simple flow-driven rigid-body motion problem.

• Set boundary conditions for internal flow.

• Compile a User-Defined Function (UDF) to specify flow-driven rigid-body motion.

• Calculate a solution using the pressure-based solver.

15.2. Prerequisites

This tutorial is written with the assumption that you have completed one or more of the introductory

tutorials found in this manual:

• Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing

Elbow (p. 1)
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• Parametric Analysis in ANSYS Workbench Using ANSYS Fluent (p. 73)

• Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 123)

and that you are familiar with the ANSYS Fluent navigation pane and menu structure. Some steps in

the setup and solution procedure will not be shown explicitly.

15.3. Problem Description

The check valve problem to be considered is shown schematically in Figure 15.1: Problem Specifica-

tion (p. 632). A 2D axisymmetric valve geometry is used, consisting of a mass flow inlet on the left, and

a pressure outlet on the right, driving the motion of a valve. In this case, the transient motion of the

valve due to spring force, gravity, and hydrodynamic force is studied. Note, however, that the valve in

this case is not completely closed. Since dynamic mesh problems require that at least one layer remains

in order to maintain the topology, a small gap will be created between the valve and the valve seat.

Figure 15.1:  Problem Specification

15.4. Setup and Solution

The following sections describe the setup and solution steps for this tutorial:

15.4.1. Preparation

15.4.2. Mesh

15.4.3. General Settings

15.4.4. Models

15.4.5. Materials

15.4.6. Boundary Conditions

15.4.7. Solution: Steady Flow

15.4.8.Time-Dependent Solution Setup

15.4.9. Mesh Motion

15.4.10.Time-Dependent Solution

15.4.11. Postprocessing

15.4.1. Preparation

To prepare for running this tutorial:

1. Set up a working folder on the computer you will be using.

2. Go to the ANSYS Customer Portal, https://support.ansys.com/training.

Note

If you do not have a login, you can request one by clicking Customer Registration on

the log in page.
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3. Enter the name of this tutorial into the search bar.

4. Narrow the results by using the filter on the left side of the page.

a. Click ANSYS Fluent under Product.

b. Click 15.0 under Version.

5. Select this tutorial from the list.

6. Click Files to download the input and solution files.

7. Unzip dynamic_mesh_R150.zip  to your working folder.

The mesh and source files valve.msh and valve.c can be found in the dynamic_mesh directory

created after unzipping the file.

A user-defined function will be used to define the rigid-body motion of the valve geometry. This function

has already been written (valve.c). You will only need to compile it within ANSYS Fluent.

8. Use the Fluent Launcher to start the 2D version of ANSYS Fluent.

Fluent Launcher displays your Display Options preferences from the previous session.

Note that this tutorial has been generated using single precision, so you should ensure that Double
Precision is disabled if you want to match the tutorial setup exactly.

For more information about Fluent Launcher, see Starting ANSYS Fluent Using Fluent Launcher in

the User’s Guide.

9. Ensure that the Display Mesh After Reading, Embed Graphics Windows, and Workbench Color
Scheme options are enabled.

10. Run in Serial under Processing Options.

15.4.2. Mesh

1. Read the mesh file valve.msh .

File → Read → Mesh...

15.4.3. General Settings

1. Check the mesh.

General → Check

Note

You should always make sure that the cell minimum volume is not negative, since ANSYS

Fluent cannot begin a calculation if this is the case.
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2. Change the display units for length to mm.

General → Units...

a. In the Set Units dialog box select length under Quantities and mm under Units.

b. Close the Set Units dialog box.

3. Display the mesh (Figure 15.2: Initial Mesh for the Valve (p. 635)).

General → Display...

a. Deselect axis-inlet, axis-move, inlet, and outlet from the Surfaces selection list.

b. Click Display.
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Figure 15.2:  Initial Mesh for the Valve

c. Close the Mesh Display dialog box.

4. Enable an axisymmetric steady-state calculation.

General
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a. Select Axisymmetric from the 2D Space list.

15.4.4. Models

Models

1. Enable the standard �- � turbulence model.
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Models → Viscous → Edit...

a. Select k-epsilon (2 eqn) from the Model list and retain the default selection of Standard in the k-
epsilon Model group box.

b. Select Enhanced Wall Treatment for the Near-Wall Treatment.

c. Click OK to close the Viscous Model dialog box.

15.4.5. Materials

Materials
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1. Apply the ideal gas law for the incoming air stream.

Materials → Fluid → Create/Edit...
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a. Select ideal-gas from the Density drop-down list.

b. Click Change/Create.

c. Close the Create/Edit Materials dialog box.

15.4.6. Boundary Conditions

Dynamic mesh motion and all related parameters are specified using the items in the Dynamic Mesh task

page, not through the Boundary Conditions task page. You will set these conditions in a later step.

1. Set the conditions for the mass flow inlet (inlet).

Boundary Conditions → inlet

Since the inlet boundary is assigned to a wall boundary type in the original mesh, you will need to explicitly

assign the inlet boundary to a mass flow inlet boundary type in ANSYS Fluent.
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a. Select mass-flow-inlet from the Type drop-down list in the Boundary Conditions task page.

b. Click Yes when ANSYS Fluent asks you if you want to change the zone type.

The Mass-Flow Inlet boundary condition dialog box will open.

Release 15.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.640

Using Dynamic Meshes



i. Enter 0.0116  kg/s for Mass Flow Rate.

ii. Select Normal to Boundary from the Direction Specification Method drop-down list.

iii. Select Intensity and Hydraulic Diameter from the Specification Method drop-down list in the

Turbulence group box.

iv. Retain 5% for Turbulent Intensity.

v. Enter 20  mm for the Hydraulic Diameter.

vi. Click OK to close the Mass-Flow Inlet dialog box.

2. Set the conditions for the exit boundary (outlet).

Boundary Conditions → outlet
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Since the outlet boundary is assigned to a wall boundary type in the original mesh, you will need to

explicitly assign the outlet boundary to a pressure outlet boundary type in ANSYS Fluent.

a. Select pressure-outlet from the Type drop-down list in the Boundary Conditions task page.

b. Click Yes when ANSYS Fluent asks you if you want to change the zone type.

The Pressure Outlet boundary condition dialog box will open.
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i. Select From Neighboring Cell from the Backflow Direction Specification Method drop-down

list.

ii. Select Intensity and Hydraulic Diameter from the Specification Method drop-down list in the

Turbulence group box.

iii. Retain 5% for Backflow Turbulent Intensity.

iv. Enter 50  mm for Backflow Hydraulic Diameter.

v. Click OK to close the Pressure Outlet dialog box.

3. Set the boundary type to axis for both the axis-inlet and the axis-move boundaries.

Boundary Conditions

Since the axis-inlet and the axis-move boundaries are assigned to a wall boundary type in the original

mesh, you will need to explicitly assign these boundaries to an axis boundary type in ANSYS Fluent.

a. Select axis-inlet from the Zone list and select axis from the Type list.

b. Click Yes when ANSYS Fluent asks you if you want to change the zone type.

c. Retain the default Zone Name in the Axis dialog box and click OK to close the Axis dialog box.

d. Select axis-move from the Zone list and select axis from the Type list.

e. Click Yes when ANSYS Fluent asks you if you want to change the zone type.

f. Retain the default Zone Name in the Axis dialog box and click OK to close the Axis dialog box.
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15.4.7. Solution: Steady Flow

In this step, you will generate a steady-state flow solution that will be used as an initial condition for the

time-dependent solution.

1. Set the solution parameters.

Solution Methods

a. Select Coupled from the Scheme drop-down list.

b. Select PRESTO! from the Pressure drop-down list.

c. Retain the default of Second Order Upwind in the Density drop-down list.

d. Retain the default of Second Order Upwind in the Momentum drop-down list.

e. Retain the defaults of First Order Upwind in the Turbulent Kinetic Energy and Turbulent Dissipation
Rate drop-down lists.

f. Retain the default of Second Order Upwind in the Energy drop-down list.

2. Set the relaxation factors.
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Solution Controls

a. Retain the default values for Under-Relaxation Factors in the Solution Controls task page.

3. Enable the plotting of residuals during the calculation.

Monitors → Residuals → Edit...
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a. Ensure that Plot is enabled in the Options group box.

b. Click OK to close the Residual Monitors dialog box.

4. Initialize the solution.

Solution Initialization

a. Retain the default Hybrid Initialization in the Initialization Methods group box.

b. Click Initialize in the Solution Initialization task page.

Note

A warning is displayed in the console stating that the convergence tolerance of

1.000000e-06 not reached during Hybrid Initialization. This means that the default

number of iterations is not enough. You will increase the number of iterations and
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re-initialize the flow. For more information refer to Hybrid Initialization in the User's

Guide.

c. Click More Settings....

i. Increase the Number of Iterations to 20 .

ii. Click OK to close the Hybrid Initialization dialog box.

d. Click Initialize once more.

Note

Click OK in the Question dialog box, where it asks to discard the current data. The console

displays that hybrid initialization is done.

Note

For flows in complex topologies, hybrid initialization will provide better initial velocity

and pressure fields than standard initialization. This will help to improve the convergence

behavior of the solver.

5. Save the case file (valve_init.cas.gz ).

File → Write → Case...
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6. Start the calculation by requesting 150 iterations.

Run Calculation

Click Calculate.

The solution converges in approximately 115 iterations.

7. Save the case and data files (valve_init.cas.gz  and valve_init.dat.gz ).

File → Write → Case & Data...

15.4.8. Time-Dependent Solution Setup

1. Enable a time-dependent calculation.

General
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a. Select Transient from the Time list in the General task page.

15.4.9. Mesh Motion

1. Select and compile the user-defined function (UDF).

Define → User-Defined → Functions → Compiled...

a. Click Add... in the Source Files group box.

The Select File dialog box will open.

i. Select the source code valve.c in the Select File dialog box, and click OK.

b. Click Build in the Compiled UDFs dialog box.
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The UDF is already defined, but it must be compiled within ANSYS Fluent before it can be used in the

solver. Here you will create a library with the default name of libudf in your working folder. If you

want to use a different name, you can enter it in the Library Name field. In this case you need to

make sure that you will open the correct library in the next step.

A dialog box will appear warning you to make sure that the UDF source files are in the directory that

contains your case and data files. Click OK in the warning dialog box.

c. Click Load to load the UDF library you just compiled.

When the UDF is built and loaded, it is available to hook to your model. Its name will appear as

valve::libudf and can be selected from drop-down lists of various dialog boxes.

2. Hook your model to the UDF library.

Define → User-Defined → Function Hooks...

a. Click the Edit... button next to Read Data to open the Read Data Functions dialog box.

i. Select reader::libudf from the Available Read Data Functions selection list.

ii. Click Add to add the selected function to the Selected Read Data Functions selection list.

iii. Click OK to close the Read Data Functions dialog box.

b. Click the Edit... button next to Write Data to open the Write Data Functions dialog box.

i. Select writer::libudf from the Available Write Data Functions selection list.

ii. Click Add to add the selected function to the Selected Write Data Functions selection list.

iii. Click OK to close the Write Data Functions dialog box.
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These two functions will read/write the position of the center of gravity (CG) and velocity in the X

direction to the data file. The location of the CG and the velocity are necessary for restarting a case.

When starting from an intermediate case and data file, ANSYS Fluent needs to know the location of

the CG and velocity, which are the initial conditions for the motion calculation. Those values are

saved in the data file using the writer UDF and will be read in using the reader UDF when reading

the data file.

c. Click OK to close the User-Defined Function Hooks dialog box.

3. Enable dynamic mesh motion and specify the associated parameters.

Dynamic Mesh

a. Enable Dynamic Mesh in the Dynamic Mesh task page.

For more information on the available models for moving and deforming zones, see Modeling

Flows Using Sliding and Dynamic Meshes in the User's Guide.

b. Disable Smoothing and enable Layering in the Mesh Methods group box.

ANSYS Fluent will automatically flag the existing mesh zones for use of the different dynamic mesh

methods where applicable.
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c. Click the Settings... button to open the Mesh Method Settings dialog box.

i. Click the Layering tab.

ii. Select Ratio Based in the Options group box.

iii. Retain the default settings of 0.4  and 0.2  for Split Factor and Collapse Factor, respectively.

iv. Click OK to close the Mesh Method Settings dialog box.

4. Specify the motion of the fluid region (fluid-move).

Dynamic Mesh → Create/Edit...

The valve motion and the motion of the fluid region are specified by means of the UDF valve.
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a. Select fluid-move from the Zone Names drop-down list.

b. Retain the default selection of Rigid Body in the Type group box.

c. Ensure that valve::libudf is selected from the Motion UDF/Profile drop-down list in the Motion
Attributes tab to hook the UDF to your model.

d. Retain the default settings of (0, 0)  mm for Center of Gravity Location, and 0 for Center of
Gravity Orientation.

Specifying the CG location and orientation is not necessary in this case, because the valve motion

and the initial CG position of the valve are already defined by the UDF.

e. Click Create.

5. Specify the meshing options for the stationary layering interface (int-layering) in the Dynamic Mesh
Zones dialog box.
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a. Select int-layering from the Zone Names drop-down list.

b. Select Stationary in the Type group box.

c. Click the Meshing Options tab.

i. Enter 0.5  mm for Cell Height of the fluid-move Adjacent Zone.

ii. Retain the default value of 0 mm for the Cell Height of the fluid-inlet Adjacent zone.

d. Click Create.

6. Specify the meshing options for the stationary outlet (outlet) in the Dynamic Mesh Zones dialog box.

a. Select outlet from the Zone Names drop-down list.

b. Retain the previous selection of Stationary in the Type group box.

c. Click the Meshing Options tab and enter 1.9  mm for the Cell Height of the fluid-move Adjacent
Zone.

d. Click Create.

7. Specify the meshing options for the stationary seat valve (seat-valve) in the Dynamic Mesh Zones dialog

box.

a. Select seat-valve from the Zone Names drop-down list.
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b. Retain the previous selection of Stationary in the Type group box.

c. Click the Meshing Options tab and enter 0.5  mm for Cell Height of the fluid-move Adjacent
Zone.

d. Click Create.

8. Specify the motion of the valve (valve) in the Dynamic Mesh Zones dialog box.

a. Select valve from the Zone Names drop-down list.

b. Select Rigid Body in the Type group box.

c. Click the Motion Attributes tab.

i. Ensure that valve::libudf is selected from the Motion UDF/Profile drop-down list to hook the

UDF to your model.

ii. Retain the default settings of (0, 0)  mm for Center of Gravity Location, and 0 for Center of
Gravity Orientation.

d. Click the Meshing Options tab and enter 0 mm for the Cell Height of the fluid-move Adjacent
zone.

e. Click Create and close the Dynamic Mesh Zones dialog box.

In many MDM problems, you may want to preview the mesh motion before proceeding. In this problem, the

mesh motion is driven by the pressure exerted by the fluid on the valve and acting against the inertia of the

valve. Hence, for this problem, mesh motion in the absence of a flow field solution is meaningless, and you

will not use this feature here.

15.4.10. Time-Dependent Solution

1. Set the solution parameters.

Solution Methods
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a. Select PISO from the Scheme drop-down list in Pressure-Velocity Coupling group box.

b. Enter 0 for Skewness Correction.

c. Retain all of the other previously set schemes and defaults.

2. Set the relaxation factors.

Solution Controls
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a. Enter 0.6  for Pressure in the Under-Relaxation Factors group box.

b. Enter 0.4  for Turbulent Kinetic Energy.

c. Enter 0.4  for Turbulent Dissipation Rate.

3. Request that case and data files are automatically saved every 50 time steps.

Calculation Activities (Autosave Every (Time Steps)) → Edit...
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a. Enter 50  for Save Data File Every (Time Steps).

b. Enter valve_tran.gz  in the File Name text box.

c. Select flow-time from the Append File Name with drop-down list.

When ANSYS Fluent saves a file, it will append the flow time value to the file name prefix

(valve_tran). The gzipped standard extensions (.cas.gz and .dat.gz) will also be appended.

d. Click OK to close the Autosave dialog box.

4. Create animation sequences for the static pressure contour plots and velocity vectors plots for the valve.

Calculation Activities (Solution Animations) → Create/Edit...

Use the solution animation feature to save contour plots of temperature every five time steps. After the

calculation is complete, you use the solution animation playback feature to view the animated temper-

ature plots over time.
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a. Set Animation Sequences to 2.

b. Enter pressure  in the Name text box for the first animation.

c. Enter vv  in the Name text box for the second animation.

d. Set Every to 5 for both animation sequences.

The default value of 1 instructs ANSYS Fluent to update the animation sequence at every time step.

For this case, this would generate a large number of files.

e. Select Time Step from the When drop-down list for pressure  and vv .

f. Click the Define... button next to pressure  to open the Animation Sequence dialog box.

659
Release 15.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Setup and Solution



i. Retain the default selection of Metafile in the Storage Type group box.

Note

If you want to store the plots in a folder other than your working folder, enter the

folder path in the Storage Directory text box. If this field is left blank (the default),

the files will be saved in your working folder (that is, the folder where you started

ANSYS Fluent).

ii. Set Window number to 1 and click Set.

iii. Select Contours in the Display Type group box to open the Contours dialog box.

A. Enable Filled in the Options group box.

B. Retain the default selection of Pressure... and Static Pressure from the Contours of drop-

down lists.

C. Click Display (Figure 15.3: Contours of Static Pressure at t=0 s (p. 661)).

D. Close the Contours dialog box.
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Figure 15.3:  Contours of Static Pressure at t=0 s

iv. Click OK in the Animation Sequence dialog box.

The Animation Sequence dialog box will close, and the check box in the Active column next to

pressure in the Solution Animation dialog box will be enabled.

g. Click the Define... button next to vv  to open the Animation Sequence dialog box.

i. Retain the default selection of Metafile in the Storage Type group box.

ii. Set Window to 2 and click Set.

iii. Select Vectors in the Display Type group box to open the Vectors dialog box.
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A. Retain all the other default settings.

B. Click Display (Figure 15.4: Vectors of Velocity at t=0 s (p. 663)).

C. Close the Vectors dialog box.
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Figure 15.4: Vectors of Velocity at t=0 s

iv. Click OK in the Animation Sequence dialog box.

The Animation Sequence dialog box will close, and the check box in the Active column next to

vv in the Solution Animation dialog box will be enabled.

h. Click OK to close the Solution Animation dialog box.

5. Set the time step parameters for the calculation.

Run Calculation
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a. Enter 0.0001  s for Time Step Size.

b. Retain 20  for Max Iterations/Time Step.

In the accurate solution of a real-life time-dependent CFD problem, it is important to make sure that

the solution converges at every time step to within the desired accuracy. Here the first few time steps

will only come to a reasonably converged solution.

6. Save the initial case and data files for this transient problem (valve_tran-0.000000.cas.gz  and

valve_tran-0.000000.dat.gz ).

File → Write → Case & Data...

7. Request 150 time steps and calculate a solution.

Run Calculation

Extra

If you decide to read in the case file that is provided for this tutorial on the Customer Portal,

you will need to compile the UDF associated with this tutorial in your working folder. This

is necessary because ANSYS Fluent will expect to find the correct UDF libraries in your

working folder when reading the case file.
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The UDF (valve.c ) that is provided can be edited and customized by changing the para-

meters as required for your case. In this tutorial, the values necessary for this case were

preset in the source code. These values may be modified to best suit your model.

15.4.11. Postprocessing

1. Inspect the solution at the final time step.

a. Inspect the contours of static pressure in the valve (Figure 15.5: Contours of Static Pressure After 150

Time Steps (p. 666)).

Graphics and Animations → Contours → Set Up...

Note

You may need to switch to Window 1 (using the drop-down list at the upper left

corner of the graphics window) to view the contour plot.
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Figure 15.5:  Contours of Static Pressure After 150 Time Steps

b. Inspect the velocity vectors near the point where the valve meets the seat valve (Figure 15.6: Velocity

Vectors After 150 Time Steps (p. 667)).

Graphics and Animations → Vectors → Set Up...
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Figure 15.6: Velocity Vectors After 150 Time Steps

2. Play the animation of the pressure contours.

a. Graphics and Animations → Solution Animation Playback → Set Up...
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b. Select pressure  from the Sequences list in the Animation Sequences box of the Playback dialog

box.

If the Sequences list is empty, click Read... to select the pressure.cxa sequence file from your

working directory.

The playback control buttons will become active.

c. Set the slider bar above Replay Speed about halfway in between Slow and Fast.

d. Retain the default settings in the rest of the dialog box and click the  button.

You may have to change the Viewer window to see the animation. In the drop-down menu at the

top of the Viewer, set the window number to 1, which corresponds to the Window number for

pressure that you set in the Animation Sequence dialog box.

3. Play the animation of the velocity vectors.

a. Select vv  from the Sequences list in the Animation Sequences box of the Playback dialog box.

If the Sequences list does not contain vv, click Read... to select the vv.cxa sequence file from your

working directory.

b. Retain the default settings in the rest of the dialog box and click the  button.

You may have to change the Viewer window to see the animation. In the drop-down menu at the

top of the Viewer, set the window number to 2, which corresponds to the Window number for vv
that you set in the Animation Sequence dialog box.

For additional information on animating the solution, see Modeling Transient Compressible

Flow (p. 257) and see Animating the Solution of the User's Guide.

c. Close the Playback dialog box.
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4. You can also inspect the solution at different intermediate time steps.

a. Read the corresponding case and data files (for example, valve_tran-1-0.010000.cas.gz  and

valve_tran-1-0.010000.dat.gz ).

File → Read → Case & Data...

b. Display the desired contours and vectors.

15.5. Summary

In this tutorial, a check valve is used to demonstrate the dynamic layering capability within ANSYS

Fluent, using one of the three dynamic mesh schemes available. You were also shown how to perform

a one degree of freedom (1DoF) rigid body FSI by means of a user-defined function (UDF). ANSYS Fluent

can also perform a more general six degrees of freedom (6DoF) rigid body FSI using a built-in 6DoF

solver.

If you decide to run this tutorial in parallel, make sure you use Principal Axes as the partitioning

method.

15.6. Further Improvements

This tutorial guides you through the steps to generate an initial first-order solution. You may be able

to increase the accuracy of the solution further by using an appropriate higher-order discretization

scheme. For a more accurate solution, you can increase the number of layers across the valve seat area.

This can be achieved either by using a finer mesh at the valve seat area and/or using a non-constant

layer height instead of a constant layer height, as demonstrated in this tutorial.
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